pp Gerer votre site web
avec Joomlal!®
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>P  Le principe de la formation

Apprendre a

gérer un site
pour ensuite

créer le votre
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>P  formateurs

Loic Martin aka lomart — lomart.fr

Développeur et webmaster ;

Utilisateur de Joomla depuis une dizaine d’années ;
Modérateur sur le forum francais ;

Créateur de modules et plugins pour faciliter 'usage de Joomla.

Fabienne Goldberg aka ghazal

Formatrice ;

Joomla Fan depuis une dizaine d’années ;

Modératrice sur le forum francais ;

Passionnée par les CSS et le JavaScript et leur inclusion dans Joomla.

Manu Alvarez aka manu93fr

Webmaster ;
Utilisateur de Joomla depuis une dizaine d’années ;
Modérateur sur le forum francais ;
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PP Le programme

Installation d’un serveur sur votre ordinateur

e installation d’un serveur web local (AMP)
* installation du site exemple
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PP Le programme

Découvrir Joomla!

* naviguer sur la partie publique : frontend

* naviguer sur la partie administration : backend

e contenu, module, plugin et template

e organisation du contenu avec Joomla!
catégories, articles et menus
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PP Le programme

Exercices pratiques

modifier un article

créer un article simple et son menu
ajouter un article blog « les partenaires »
installer un composant et 'utiliser

créer un module personnalisé

utiliser un plugin de contenu

ajouter des regles CSS
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PP Le programme

et pour terminer,

on discutera de votre projet
de création d’un site Internet

T '“ - PARIS 18 & 19 MAI 2018

4
A* =
\“'t‘_ JOOMLADAY FR



pP  Journée Grands Débutants

C’est parti
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pP  |nstallation

Joomlal!, comme tous les sites Internet
a besoin d’un environnement matériel

* votre ordinateur (installation locale)
* un hébergeur (installation distante)
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pP  Hébergeur distant

* disponible 24h/24h

* haut débit

e seécurité matérielle
 gestion nom de domaine

Quelques hébergeurs :
1&1, o2switch, OVH, siteground, ...
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pP  votre ordinateur

les moins
 disponibilité limitée
e débit limité

les plus

* souple pour concevoir un site
* pas de connexion internet requise
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pP  |nstallation

Joomla!, comme tous les sites Internet
a besoin d’un environnement logiciel

¢ Apache est un serveur HTTP (plus de la moitié des sites dans le monde)
° |V|ySQL est un gestionnaire de base de données

®* PHPestun langage de programmation
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>

le principe
client-serveur

§sav

[__c_ie données dynamiques |

Ressources

images/videos
feuilles de styles CSS
javascript

' JOOMLADAY FR
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~ le navigateur demande
une page au serveur
URL

Les scripts PHP
générent un fichier HTML

mis a disposition du client |

Le client
demande et réecupére

. les ressources indiquées
~dans le fichier HTML

CLIENT

& jauery

JS
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pP Installation d’un serveur local AMP sur votre ordinateur

* Pourles PC Windows
* Copie et extraction de UwAmp

e Pourles MAC & LINUX

 |nstallation de Bitnami
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pP Installation d’un serveur local AMP sur votre ordinateur

Sur la clé USB, vous trouverez :

* Dossier Serveurs local
*  UwAmp pour PC
* Bitnami pour MAC
* Bitnami pour LINUX

* Les autres dossiers sont communs PC, Mac et Linux

* |esite exemple : maison-joomla
* des ressources (extensions Joomla, textes, images)
* documentation : Joomla 3 — Le livre pour tous
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pP Installation d’un serveur local AMP sur votre ordinateur

Suivre la procédure sur la fiche qui vous a été remise
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pP Installation d’un serveur local AMP sur votre ordinateur

Maintenant que tout le monde
a un serveur AMP opérationnel,
on va installer un site Joomla
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pP  Restauration du site de démo

Sauvegarde et restauration
sont 2 opérations courantes et trés importantes

Copier le dossier « maison-joomla » de la clé dans le dossier :

 PC:C:\UwAmp\www
 MAC : /Applications/mampstack-x.x.xx-x/apache2/htdocs
* LINUX : /dossier personnel/bitnami/apache2/htdocs

T '“ . PARIS 18 & 19 MAI 2018

4
A» = -
‘M't“ JOOMLADAY FR



pP  Restauration du site de démo

* lancer votre navigateur Internet :
firefox / chrome / safari
 taper 'URL suivante:
* PC:localhost
* MAC:localhost:8080/maison-joomla
* LINUX:localhost/maison-joomla

*—EI: . '“ ~ PARIS 18 & 19 MAI 2018
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pP  Restauration du site de démo

Uniquement sur PC |
Vous pouvez gérer
visuellement plusieurs sites

Cliquer sur : maison-joomla £
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pP  Restauration du site de démo

Cliquer sur le dossier maison-joomla

Vous devriez voir plusieurs fichiers :
* en-GB.kickstart.ini
e fr-FR.kickstart.ini
* jquery.min.js
* json2,min.js
* kickstart.php
* maison-de-joomla.jpa

Cliquez sur kickstart.php
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pP  Restauration du site de démo - 1

CI iq uez sur I e I ie N b I eu o e e e e A [

. Kickstart n'est pas un programme d'installation. Il s'agit d'un outil d'extraction d'archives sur serveur PHP. Le programme
b d d'installation réelle a été mis a l'intérieur du fichier d'archive lors de la sauvegarde.
a u a S u m e S s a ge . Kickstart n'est pas le seul moyen d'extraire I'archive de sauvegarde. 5i vous étes sur PC, vous pouvez également utiliser Akeeba
eXtract.

. Kickstart est liée & la configuration de votre serveur. Suivant celle appliquée, Kickstart peut ne pas fonctionner.

. Vous devez télécharger et envoyer les fichiers d'archive en mode de transfert FTP binaire. Un autre mode de transfert peut
corrompre |'archive et empécher sa décompression.

. Les erreurs de post-restauration sont généralement causées par le fichier .htaccess ou les directives du fichier php.ini. Les erreurs
de pages blanches, 404 et 500 peuvent souvent &tre évitées en modifiant les fichiers .htaccess et php.ini. Cette adaptation ne

peut pas &tre automatisée au risque de créer des vulnérabilités. Contactez votre hébergeur si vous ne savez comment vous y
prendre pour les modifier ou que vous n'avez pas accés au fichier php.ini.

. Kickstart écrase les fichiers sans demande de confirmation. Il est conseillé d'effectuer une sauvegarde des fichiers avant de les

remplacer.

. Vous ne devez pas remplacer les fichiers temporaires du cPanel de I'hébergeur (par exemple http://1.2.3.4/ ~ username) car cela

empéche |a restauration et bloque temporairement I'accés du site.

. Vous étes censé lire la documentation avant d'utiliser ce logiciel. La plupart des problémes peuvent étre évités, ou facilement

contourné.

. Ce texte ne signifie pas qu'un probléme a été détecté. Il s'agit d'un texte affiché par défaut au lancement de Kickstart.

Cliguez ici ou appuyer sur la touche "ESC' pour fermer ce message
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pP  Restauration du site de démo - 2

o Extraction des fichiers

Cliquez sur démarrer [

# Akeeba Kickstart Core 5.4.0

I’archive est O Exracton
décompressée sur
votre ordinateur
patientez ...

: fUwAmp fwww /J386-IDG- 2/media/media/js/mediafield. s
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pP  Restauration du site de démo - 3

Cliquez sur

« Exécution du programme d’installation »
la page suivante, cliquez sur

le bouton « Suivant »

Note: en local, il est normal de ne pas avoir tous les
indicateurs au vert

JOOMLADAY FR

ANGIE - Akeeba Next Generation Installer Engine v.6.0.1

Pré-installason ¥ Restauahon de la Dase o o le'll'léé'in »  Confguration du sile »

Verification de pré-installation

Siun de e Slments Vs DEE D 8n Chanps (manges un nol, wailez prendre des
SeSUres pour effeciuer les adaplalions nécessaires. We pas ke lare pourmail condure &
uné irslalalion Rcomecie

Paraméires Coaurant

Nershoa FHP > 531

Suppon de Compression b

HEENELE
HHEBHH
HH W
I I
1l
EEEEEEEEE

Information de sauvegarde

Ces informations ont &4 recuailes au moment o2 la sauvegante. Eles représenient la
COMJURARON G SEreeur & 0k du sile sauvegande. EBes re Soni présentées io gue pou
rEfErente & pour Waciner e debogags

Paramairas Temps dé sauvegarde
o of Gl g Jomartir
Diabe 3¢ saMBIANE ORI B A2 T
Wersion Asreta Backup [hia
wersion PHP [7.0.26]
Ritperioke Fock [ommamc e

I Commsulier README himi
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Teming

R oiimer el _ = Sureant

Paramétres recommandés

Ces parameires PHE sont recommandis pour assurar una pleing fonclionnalid de
Joomia. Touledos, meme S wis paamelnes ne comespondent pas exactement & 1a
confguralion recommandds, Joomia foncliormera

Paramétres Recommandé Courant
EIM = ===
T = =3
 irunctras | v frers
(OutpatBafteceg ] === =3
= E=E=m
T =3 =3

Information du site

il infoemnation represante la gl QUIETICN i SETVELIT BUT lequal C& programime
O irElaRAGoN 851 en oS Rt ulion (SUr lequel B resauration sea effeciude)
version Joomia! 386

version FHP 703
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pP  Restauration du site de démo - 4

; = Pricédent
© serveur base de données B —— s

.
localhost

Pri-installation » Restauration de |a base de données » Configuration oy ske ¥ Terming

@ nom utilisateur et mot de passe Restauration de la base de données principale du site

Information de connexion Options avanceées

L]
P C [ r o o t et ro o t Type e base de MySQLI {de préférence) .'- [+ ] Tables ensianies m Sauvegarder @
donnses
I - Préfue des tables g o
M aX & L I n u X . Senveur hdle de la base o alhost L]

di données | Supprimer les wanficalions oe ch erangéres @

ce ux indi qUés Hom dutiisateuwr T

Mot 38 pEssE eses

lors installation Bitnami e

donimees

¥ Aucune valeur aulomaliques pour oo

Utilisez REFLACE & la place de INSERT @

e o 8

BO - Forcer la coliation UTF-8 @

Tatkes - Forces la ealiation UTF-5 @

9 nom base de données
maison-joomla

Auinriser [ détection automabgque UTFEMB @
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pP  Restauration du site de démo — 4 suite

Restauration de la base de données

on patiente durant la restauration —

de la base de données

Restaure 14539 KB

Taille totale 1.06 MB

Temps restant estimé 2 minutes

Restauration de la base de données

La restauration de la base a été effectuée avec succés

Cliquez sur le bouton ci-dessous pour fermer cette boite de dialogue et passez a
I'étape suivante du programme d'installation

l & Etape suivante |
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pP  Restauration du site de démo - 5

indiquer
e votre adresse email
* le mot de passe (password)

Parametre Super utilisateur

Super utilisateur admin E‘ 2]
E-mail | admin@votresite fr (2]
Mot de passe (2]
Mot de passe (2]
(vérification)

’A: . 'I' 8
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Parametres du site

MNom du site
Adresse e-mail du site

Mom d'expediteur des
e-mails

URL du site en ligne

Forcer SSL
Domaine des cookies
Chemin des cookies

Activez I'envoi de
courrier

La Maison de Joomla 2]
admin@votresite fr (2]
JOAY-2018 (2]
1]
A
Aucun E‘ L]
2]
(2]
) MNon @ Oui

[[] Remplacer les chemins tmp et log @
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pP Restauration du site de démo - 6

ANGIE — Akeeba Next Generation Installer Engine v.6.0.1

Vious n'avez aucune idée de ce que vous étes censé faire ? Ne paniquez pas | [ IEEEAEN R CR Gleih e !
Pré-installation » Restauration de |la base de données » Configuration du site » Terminé

On y est presque!

Fermez cette fenétre pour revenir & Kick Start. Cliguez sur Nettoyer (clean up) pour supprimer les fichiers d'installation et commencer & utiliser le site restauré

La restauration est terminée
fermer I'onglet de cette page dans votre navigateur

PARIS 18 & 19 MAI 2018
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pP  Restauration du site de démo - 7

4 Akeeba Kickstart Core 5.4.2

G Restauration et nettoyage

cliquer sur Nettoyage
pour supprimer les fichiers
d’installation

# Akeeba Kickstart Core 5.4.2

Cliquer Sur @ Restauration et nettoyage
Accéder au frontal du site
pour voir le site public
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pP e site de démo : La maison de Joomla

c’est une version basique de Joomlal

Pour gagner du temps, quelques extensions ont été ajoutées.
Elles seront signalées au fur et a mesure de leur utilisation

-

W
\m o e ce site contient plein d'informations qui vous seront utiles par la suite.
Y n’hésitez pas a le compléter au fur et a mesure de votre découverte de Joomla!
ﬂ/ﬁ _ ' DT PARIS 18 & 19 MAI 2018
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>

le site coteé visiteurs

* |a partie centrale : le contenu
* articles, e-commerce, annuaires, ...

e autour : les modules
* menus, recherche, identification, ...

* [I’habillage : le template

- L] .

JOOMLADAY FR

La Maison de

Joomlal

Les amis REEIGUGHELGEN Contact

Visteurs Administration Installation

en périphérie : modules

Javascript et jQuery

lauery Le javascript et sa bibliothéque jQuery sont exécutés coté client pour apporter

de l'interaction et de I'animation

Volre serveur HTTP transmet les fichiers nécessaires qui seront
exécutés par le navigateur de l'internaute

Coté navigateur

"o

B s

Pour un site simple, vous n'uliliserez pas direclement les scripls JS. Par contre, Joomia et des
extens:ons les utiisent

Zone centrale : composant

Les nouveautés

¢ La maison coté
cCuISIng

o Installation d'un

Vous étesici -~ Accuell » Les parienaires » Javascript et jQuery

Connexion
1

Se souvenir de moi

Connexion

|dentifiant oublé ?
Mot da passe oubls 7

Mentons légales © ort Ltiine voun Aoeoee limete
Le LJ!’JH nia ir
Le forum joomia Ir

Assocation Frascophone
s Utiicateurs de Joomia!*

Joomin w woue A - dw O So
m.r- mondial 6e 1s MaeGus AFULE west 71 aRlie & Cpe
1 J00MAIS i BODIDUWE DX QUX

© 2018 La Maison de Joomia

#JJ18FR

Haut de page
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pP  |e site cOté administration

Pour y accéder,
on ajoute "administrator" a I'URL du site

Exemple :
http://localhost/maison-joomla/administrator
http://localhost:8080/maison-joomla/administrator

s i '| ) - PARIS 18 & 19 MAI 2018
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http://localhost/maison-joomla/administrator
http://localhost/maison-joomla/administrator
http://localhost/maison-joomla/administrator
http://localhost/maison-joomla/administrator
http://localhost/maison-joomla/administrator
http://localhost:8080/maison-joomla/administrator
http://localhost:8080/maison-joomla/administrator
http://localhost:8080/maison-joomla/administrator
http://localhost:8080/maison-joomla/administrator

pP  |e site cOté administration

Il faut montrer patte blanche

La Maison de

al Joomlal

x| ° saisir les identifiant
" @
= [ et mot de passe

spécifiés lors de la restauration

I'I= =JDI8FR PARIS 18 & 19 MAI 2018
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pP  |e site cOté administration

© Panneau d'administration

O vers le site cote visiteurs (nouvel onglet). -
® menu pour administration S—

® action en cours
O raccourcl vers actions courantes

® messages "systeme E
® modules avec diverses informations Mo e

@ barre de statut

L & malson cote cuisine Super Utisge:

3:'- . ' - PARIS 18 & 19 MAI 2018
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pP  |e contenu

| La Maison de
‘@le | ||O! | en périphérie : modules

e C(’estle composant principal de Joomla

e |l s'agit d'articles (textes + images)

AF)) @ 9 SEsrsrmrmrie et [ £}
et k;y

* |es articles sont organisés en catégories.

* |es articles sont affichés dans la partie centrale du site

*—EI: . '“ ~ PARIS 18 & 19 MAI 2018
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le contenu

Le menu contenu > articles affiche la liste des articles

La Mason de J.. of 1 -

H Sysléme - Wilisaleurs -~ Menus = Conlenu ~ Composants - Exlensions - Aade -

D) Articles 1 g Joorriarl

m B Medilier " Pukbier B Dépublies & Melie en vedetbs W Me pas metine envedetls & | Aichier B Deeesrouiber W | Trailement O | Corbeille g A | Paraméyes

_ o Oulil= de recherche = Effacer o 0 descendant - o o=
Catégones
sl - Sélectionner un st - - - Sélectiorner una langus - -

Aflicles en vedella

Champs Ralectionner les nresauy max. =

Groupes de champs

= Statunt Titre Arcig Aurteur L anigua: [Mate de création  Clics =

adminkirataur Toutes 10M21E “ 15

k- B SEC - Search Engme Optimisation (Akes : sep-search-sngine-cotimsston) Zcces publ
Cuibgorie: Paricnaines

e CHS (A o) o Arces pubbz S mmElrateur Towizs H0AE B 15
]

Caiégore: Parienaine

Aceis publz Adminttrateir Tinirie:z 10031 E n 14

oo T Jawasenpt et [Query ams : pvascrpl-st-gueny)

CalEgora. Parlaidinas

1) g PARIS 18 & 19 MAI 2018
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PP le contenu Erors
/C@

le but : modifier I'article en page d’accueil

e tapez « visiteurs » dans la zone de recherche
* cliquer surlaloupe
* cliquer sur I'unique résultat

‘}__ j_'l.— 'I' «JDISFR PARIS 18 & 19 MAI 2018
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le contenu

Modification
d’un article

Modifier

e ¥ Ervegsyer § Fammet +  Entegener 8 Noweas 1% Ewregisterune Gspe a8 wouons
v ¥ H

Tes®  La maison cote visiteurs o As | man

e i . ]

e @ [

Edter = inserer = Voir = Format » Tabicau = Outss

B J U 5 E T 3 B Fumstsv Paagiphe =  senf . - B =B
E & r PO IR o ATA-H @, X QOB —-85%

X D0 8 ¥ 9 & 6680 & @ 3 ©-L [Qucse gpuen oo [ At
Rimape Dy sanoepage W Lrstasute

Nous vous souhaitons la bienvenue dans le monde de Joomla que nous aimerions tant
partager avec vous.

0 Ce site, réalisé par des modérateurs du forum de Joomla.fr, joue sur Manalogle entre

une malson et Joomla pour mettre en avant les points importants qul sont aussi &

souvent des points de blocage pour les nouveaux arrivants

La Maison de
(i3 Joomlal! on Bpiilith 1 modiles

Javascript ot |Query L% nexwesnty
¢ JOuRry o weminet o fovery At ebend [ i 2

Catégarm *

Nen candgonsé -

Envedetrs

Note o varson

Coneencn
L]
L]
Tarnm snnteaka o anmemmnen . = =
<] Mals 212
@ Bascuw [6thes
ehste | @ Umran @ irevvmnn @ -

#JJ18FR
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>P e contenu Srern
/C@

Pour voir le résultat :
* cliquez sur le nom du site en haut a droite

La Maisonde J... & X ~

¥ Joomlal

* |e site s'affiche dans un nouvel onglet
* naviguez vers la page

‘}__ j_'l.— 'I' «JDISFR PARIS 18 & 19 MAI 2018
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>P  |e contenu : gestion des catégories

 permet de créer, modifier et supprimer les catégories

 L'édition d’une catégorie permet de définir les
informations affichées lors d’un affichage en mode liste
ou blog des articles d’'une catégorie
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PP |le contenu : gestion des champs

Une fonctionnalité puissante
trop puissante pour étre vue lors de |la
découverte de Joomla!

voir les articles de Marc Dechevre

Les Champs Personnalises (Custom Fields) dans Joomla!
Aller plus loin avec les Custom Fields

‘}__ j_'l.— 'I' «JDISFR PARIS 18 & 19 MAI 2018
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https://cinnk.com/magazine/juillet-2017/977-les-champs-personnalises-dans-joomla
https://cinnk.com/magazine/juillet-2017/960-custom-fields-bonus

PP le contenu : gestion des médias

Dosslers

AFVIC S B loomiar Boomiar B e &) oS

~
1 Joomial A Joomial @

* |e menu contenu > medias permet de voir et gérer
toutes les images/vidéos/musiques
présentes dans le dossiers images du site

* une autre facon d’y accéder est d’utiliser un serveur FTP

‘}__ j_'l.— 'I' «JDISFR PARIS 18 & 19 MAI 2018
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pP  les menus

Leur role : changer le contenu affiché
dans la zone centrale de votre site.

v Menus ~ | Contenu ~ Comp

ére * un menu propose plusieurs choix

' Tous les liens de menu * un menu est affiché par un module

adifi ) lépublie
| Site !

* un site peut avoir plusieurs menus

Menu bas
Menu principal &
Site

PARIS 18 & 19 MAI 2018
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i= Menus . Joomial
PP les menus e — Blicorc

Lign de menu e = » Publigjs) @ Dépubliais) W Dans la corbeille & Module{s) de menu assignés] Id

Type de mens

m Modules - 1

les menus contiennent des liens de menu

B Systéme - Utlisstewrs ~  Menus ~  Conbenu - -ompasanis » Exdensions »  Ade -

La Maison de J... i -

= Menus: Liens de menu (Menu principal) il Joomilal

Le menu avec I'étoile jaune S satn i e+

définit la page principale de votre site — —

(page d’accueil ou homepage) t o (2]

'“ " LR PARIS 18 & 19 MAI 2018

JOOMLADAY FR




pP  les liens des menus

¥ Joomial o
un titre et alias unique
o le composant
- et son type de presentation
| — le lien parent
° o
le niveau d’acces requis
J;I—-:— _ 'l" D PARIS 18 & 19 MAI 2018



>P  créer un article simple

2 Enregistrer +" | Enregistrer & Fermer 4 | Enregistrer & Nouveau [ | Enregistrer une copie @ | Fermer

Titre de menu ™ | Mentions |légales Alias | mentions-legales
Détails Paramétres Type de liens Paramétres d'affichage de la page Métadonnées Assignation de modules

Type de lien de menu * Article

Sélectionner un article * Sélection dVun article [ Sélection | @ Créer /

URL du lien index.php?option=com_content&view=article

JOOMLADAY FR

g*erc ;
o Q

1. aller dans « Menu bas »

2. créer un lien de menu

« titre: Mentions legales
 type: article > article

cliguer sur créer

#JDIBFR PARIS 18 & 19 MAI 2018



>P  créer un article simple SN
/C@

1. indiquer le titre : Mentions légales

2. saisir le contenu.

Le texte est disponible dans la clé USB :

\ressources\texte & images\mentions-légales.html
Il faut ouvrir le fichier avec un éditeur de texte (notepad), le
sélectionner et copier le texte dans le presse-papier

Dans I’éditeur de joomla, cliquer sur [basculer I’éditeur] avant de coller
le texte

PARIS 18 & 19 MAI 2018

hﬁ_ -
) , ' I ' #JDIBFR
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PP créer un article simple - 2 5*%

Z Articles : Modifier

B Enregistres ' | Enregistrer & Fermer + Ervegaver & Nouveau [y | Enregister une cople & \ersions © Femmer

Tire*  Mentions légales Alias nentions-legales

Onglet Publication

* Date de publication e
* Description pour Google -
* Robots pour Google fretrT i

Nom de remplacemant

. > nitps://www joomla friassociation/adherer v
URL (alias) P J

Devenez adhérents de [Association Francophone des Utilisateurs Joomlal pour soutenir les actions de

Titre (65 max) Adhérer a I'AFUJ - Joomia!
Description (165 ma)() —7 votre assaciation et accéder aux senices résenvés aux r

I'I= =JDI8FR PARIS 18 & 19 MAI 2018
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> créer un article simple SN
/C@

1. cliquer sur « Enregistrer & Fermer » lI'article
2. cliquer sur « Enregistrer » le menu laMaisonde J_ & 2
3. cliquer en haut a droite pour voir le site &1 Joomlatl
4. cliquer sur le menu en bas du site pour afficher I’article
q:A: — 'I ' #JDI8FR PARIS 18 & 19 MAI 2018
‘D, "‘ JOOMLADAY FR



>P  créer un article simple

Nous avons appris :

* Ccréerun menu

e créer un article directement

 geérerles données pour les moteurs de recherche

‘}__ j_'l.— 'I' «JDISFR PARIS 18 & 19 MAI 2018

B
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PP Référencement naturel  sonersraru- sooma

https:/fwww joomla_friassociation/adherer
Devenez adhérents de I'Association Francophone des Utilisateurs Joomla! pour soutenir les actions de
votre association et acceder aux services résernves aux

Pour que votre site soit connu des moteurs de recherche :

e titre de l'article de 65 caracteres maxi. Il doit contenir les mots

importants pour étre trouve, mais rédigé d’une facon qui donne envie
de cliquer

e alias avec uniquement les mots tres importants. il doit étre unique
dans le site

* une meta-description de 165 caracteres maxi qui informe et donne
envie d’en savoir plus

B=
-2
!

'I ' #JDIBFR PARIS 18 & 19 MAI 2018
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pPp  Référencement naturel

Google apprécie beaucoup :

gue votre site soit adapté pour les smartphones (responsive)

qu'’il soit léger et rapide a charger (3/5s maxi)

qgue le contenu d’une page contienne suffisamment de texte
(200 mots minimum, plus si possible)

qgue d’autres sites en parlent (backlinks)

gu’il soit ancien (date du nom de domaine)

|

JOOMLADAY FR

le plein de conseils sur : www.abondance.com

#JJ18FR
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pP  Référencement naturel — structuration sémantique

Si votre template est bien fait, il suit les regles préconisées.

Dans vos articles, vous devez respecter ces regles simples :

* ne pas utiliser les balises H1 et H2 si votre template les utilise

* respecter une hiérarchie dans les sous-titres : H3, H4, H5, H6

* le contenu doit étre dans des balises P

e utiliser les balises STRONG et EM pour mettre en avant des passages
* mettre des textes alternatifs aux images

- _ '| D T PARIS 18 & 19 MAI 2018
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pPp  Référencement naturel

Quelques conseils pour vos articles :
* ne pas utiliser des tableaux pour la mise en page

i 'Il B . PARIS 18 & 19 MAI 2018
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>P  créer un article blog

1. ajouter un article (menu contenu)

titre : Nouveau partenaire

catégorie : partenaires

saisir le texte ;: texte d’ introduction
cliquer sur le bouton « lire la suite »
saisirletexte:et ici la suite du texte

2. enregistrer

ﬁ

ﬂ'ﬁ

' JOOMLADAY FR

#JJ18FR

- Aricles en vedette

-~ | Contenu ~ | Composants ~ Extensions ~  Aide ~

Catégories

b | Déverrouiller

PARIS 18 & 19 MAI 2018



PP créer un article blog 'S*%.
IC@

Ensuite, aller sur le site dans le menu « Partenaires »

_ La Maisonde La Maisonde
2| Joomildl 2 Joomlal

Visiteurs  Administration Installation Les amis L EEGE Glos: ) ) B .
Visiteurs  Administration  Installation  Les amis [EEGERGREGEIGEEE Glossaire Co

Nouveau partenaire Les relations entre part Nouveau partenaire
texte d'introduction Le WEB est basé sur un systéme o texte dintroduction
3 Lie Iasute - Nowesu patensre IR . ici 12 suite du texte
| SERVEUR |
= Sl Vous étes ici - Accueil + Les partenaires + MNouveauw parfenaire
- tmcturn i ",..':'.":-::.:".,:,'

(5 SrBr®

I'I= =JDI8FR PARIS 18 & 19 MAI 2018
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>P  créer un article blog

Nous avons appris 2 choses importantes :

e votre article est automatiquement affiché
par le menu de type « blog d’une catégorie »

* un article peut étre composé d’un texte d’introduction

affiché en vue blog, d’un bouton « lire la suite » et de
I’article complet

ﬂ,ﬁ s _ ' | DT PARIS 18 & 19 MAI 2018
k JOOMLADAY FR



> hiérarchie des parametres

une notion a maitriser

Pourquoi les articles sont sur 2 colonnes ?

1. dans les parametres des articles, on donne le mode de présentation par défaut

dans I'onglet « Blog/En vedette »

2. dans le lien de menu du blog, on surcharge les préférences

Articles Agencement Catégorie Catégories Blog

(1) t appliquent fiichage d B
Articles en pleine largeur 1
Introduction des articles 4

Nombre de colonnes

Parameétres articles

'-.}ﬁ:_ .
:. I '
N == -
X JOOMLADAY FR

n vedette Listes

Titre de menu * | @s partenaires
e Détails Catégorie Affichage du Blog Paramétres

Si un champ est laissé wide, les paramétres globaux seront utilisés

\ Articles en pleine largeur
\ Introduction des articles

Parameétres menu
Nombre de colonnes 2

#JDIBFR PARIS 18 & 19 MAI 2018



Qd ==
>P 2 boutons a ne pas oublier o) oo

LaMaisonde J . & X -

¥ Joomlal’

8 side R | Paramétres

aide : des infos en francais sur I'action en cours

parametres : quand le résultat n’est pas celui attendu, regardez-les

‘}__ j_'l.— 'I' «JDISFR PARIS 18 & 19 MAI 2018
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>

les composants

e

25

pa

PL

on

Composants = | Extensions -

Akeeba Backup

Associations multilingues

Banniéres

Fiches de contact nti
Fils dactualite =1
Liens web By

Messagerie privée

Messages de post-installation
Mise a jour de Joomlal
Recherche

Recherche avancée
Redirections

Tags

2 types :

les composants frontend
ils sont affichés dans la zone centrale du site

= e-commerce, formulaires, annuaires, ...

les composants backend
ils servent a la gestion du site

" sauvegarde, redirection, mise a jour, ...

PARIS 18 & 19 MAI 2018
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>P  |es composants

Avant de continuer,
on va faire une sauvegarde
avec le composant Akeeba Backup

i 'Il - - PARIS 18 & 19 MAI 2018

4
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>P  les composants

f  Akeeba Backup ::

« > »
menu « composants > Akeeba Backup

#1. Dofauk Backup Profila -

Sauvegarde en 1 clic

@ lancer la sauvegarde

Diafaut
Backip Profle

(2 télécharger la sauvegarde

Fonctions de base

Vous pouvez aussi la récupérer par FTP samorie  Auwuie | ouedn  Cotmeior  Apitfcas
dans le dossier :

/administrator/components/com akeeba/backup

I' I = #JDI8FR PARIS 18 & 19 MAI 2018
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pP  gérer les extensions

4 Extensions : Installation b4 Joomilal’

© Ace O Paramites

installation
d’une nouvelle extension

Joomla! Extensions Diroctory™ (JED) est mantenant disponible avec Installer & partir du YWeb sur cette page. En cliquant sur le bouton
Ajouter I'onglet “Installer & partir du Web™ ci-dessous, vous signfez volrs accord avwe les Conditions géndrales ¢ wtilisation & JED

ins QUIVOC 10utes los Condilions de hoense sppicables sux extensions tirces

Aputer longhet Tnstaler & patet du Web® <3

psanis = | Extensions = | Aide -

. . Transférer et installer une extension Joomia
Gérer Installation

Mises a jour

Modules Gestion ‘ﬁ\“
_. - . l—;
Plug-ins Découvrir
TEH’Ip|EItES Basze de données Glisser-déposer le fichier a transférer
Langues Avertissements

i Taile madmum de téléchacgament - 5120
Installation de langues a mun aegermant

Sites de mise a jour

o . PARIS 18 & 19 MAI 2018
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>P installer un composant 5
C/C\@

faites glisser le fichier sur la clé
« ressources/extensions/pkg-weblinks-3.6.0.zip»

sur cette zone

Transférer et installer une extension Joomia

.L/

Glisser-déposer le fichier a transférer

oo
c’est tout !
) _
. 'l"- - PARIS 18 & 19 MAI 2018
JOOMLADAY FR




>P  utiliser un composant SN
/C@

« composants > liens web > catégories »
=» créer une nouvelle famille de lien : « les amis »

« composant > liens web > liens »
=» cliquer sur le bouton nouveau
pour créer des liens vers les sites web « amis »
a récupérer dans ressources\texte & images\ liens web.txt

« Menus > Menu Principal > Ajouter un lien de menu »

=» créez un menu « les amis »
de type « Liens web > liste des liens d’une catégorie »

'I ' =JDI8FR PARIS 18 & 19 MAI 2018
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pP  utiliser un composant

Nous avons appris :

* installer une extension
* |a paramétrer

* saisir du contenu

* Créerun menu

La Maison de

2l Joomlal

Visiteurs  Administration  Installation EEEEMIEE Les partenaires  Glossaire

X
e_' Clee

Les amis de Joomla

20 |v
® Le forum
Ce forum est I'endroit ou poser vos questions
¢ La JED ( Joomla! Extensions Directory™)

En anglais, ce site de Joomla.org propose prés de 8000 extensions pour enrichir votre site

¢ Le portail frangais de Joomla

Le site de l'actualité francaise de Joomla. C'est sur ce site que vous pourrez télécharger les
versions francaises de Joomlal

¥ La base de connaissance

Un tout nouveau site de I'AFUJ qui permet d'avoir des explications claires sur les messages

d'erreurs affichés sur votre site. |l propose également des fiches pour les procédures
courantes.

I
I ' I = =JD18FR

JOOMLADAY FR

Vous étes ici - Accuell » Les amis
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>P  |es modules

4 La Maisonde
L3 JOO' | |IO! en périphérie : modules
l Visdeurs Administration 1staliahor Les amus Contact |

Javascript et jQuery Les nouveautés

& jQUEI'V Le jJavascript et sa biblothégue JQuery sont exécutés coté client pour apporter

de Nnteraction & de Manimation
Votre serveur HTTP transmet ies fichiers nécessamres qui seront
e S I I l O l | e S e | l O l I r e | I exbeutés par o navigateur de Nintermauto
B 1
o
Pour un sile simple, vous n'utiserez pas direciement les scnpts JS. Par contre, Joomia et des
axtensions les ublisent Se souvenic de moi

Zone centrale : composant \densiient oublé ?
Mot de

Connexion

Vous étes icl . Acceaill « Les panenaires » Javascnpt & jQuery

Srithe 30 Open Sawien Maten e
st 41 MR B Span Sasson Maker oy &

© 2018 La Marson de Joomla Haut de page

I'I = #JDI8FR PARIS 18 & 19 MAI 2018
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pP |3 liste des modules

W Modules (Site) ¥ Joomlal

© Nouveau @& Modifier Yy | Dupliquer v | Publier © Dépublier M  Déverrouiller [®]  Traitement @ | Corbeille 8 Paramétres

@ Aide

Site v Q Outils de recherche « Effacer ID ascendant v 20 =
Statut Titre Position Type Pages Acces Langue Id

v - Menu principal m Menu Tout Acceés public Toutes 1

v - Connexion m Connexion Acces public Toutes 16

vV v Fil de navigation m Fil de navigation Tout Acces public Toutes 17

un module n'est pas affiché par un menu.

mais un item de menu peut indiquer les modules a afficher

'“ " LR PARIS 18 & 19 MAI 2018
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pP  |a position des modules

@ La Maisonde

JOO' | 'lO! en périphérie : modules

Sl | peiors

iti avascript et jQuer
pusltlnn T e T J pt et jQuery Les nouveaurés
lam | pw-uu!p( ot 58 bt ogus JQuery sont cedculiés coté client PoUT AppoMer
da Nneracton et de Mnmabon

ulsine
* stalation dun
VB L8
o U'repetieur de code
o \s st

Volre secveur HTTP ramsmel ks fichiers nécessares qus sevont

expoutes par le nenagatowr de Imiermanse
Connexion
1
Four un sie simpla, vous nutiiserar pas dractamant ks scnpls JS. P a
i S Ul Se zomvers o ol
osition-8 sition-7
P Po Zone centrale : composant dortitart cuble
Mot do passo oubl

fous des i Accoe BS parlpngres Javasctipl ot (Ouery

pus-tmn AFUI ) R R AT e (]

o-um.n-w

fu-uter © 2015 La Marson e Joors

dehug

un module est affiché dans une position définie par le template

I' I = #JDI8FR PARIS 18 & 19 MAI 2018
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pP  L’assignation des modules

%% Modules : Connexion

[ Enregistrer " | Enregistrer & Fermer 4+ | Enregistrer & Nouveau [y | Enregistreru

Tire * | Connexion

Modulg Assignation des menus Paramétres avancés Droits
Assignation a... Uniguement les liens sélectio... =
Sélection des menus : Sélection: Tout, Aucun | Etendre: Tout, Aucun

e -

[ Mentions légales (Alias : mentions-legales)

Le portail joomla.fr (Alias : le-portail-jpomla-fr)

Il est possible de
sélectionner les pages :
ou sera affiché le module

Visiteurs (Alias : home)

(-] Administration (Alias : administration) -

[ Présentation (Alias : presentation)

o . PARIS 18 & 19 MAI 2018
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PP créer un module personnalisé

> w N e

0 N O W

dans la page des modules, cliquez sur nouveau
choisir "'module personnalisé”
donner un titre : La famille joomla

insérer I'image du logo (bouton Eaimage )
ressources/texte & images/joomladay-2017.]jpg

mettre le module dans la colonne de droite : position-7
enregistrer et tester en frontend

trier la liste des modules sur la premiere colonne (tri)
glisser le module pour le mettre en haut de la colonne

- ' I ' #JDI8FR

JOOMLADAY FR

éihSnc.
QQQ

La famille Joomla!
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pP  |es plugins

La plupart du temps, .
vous ne les voyez pas ! .

pourtant ils rendent
enormement de services

EIA = - ' JOOMLADAY FR

s'identifier sur le site

ajouter du contenu « complexe »

les éditeurs pour saisir votre contenu
faire des recherches

nettoyer les caches

prévenir des mises a jour

faire des URL lisibles par Google

etc

#JDIBFR PARIS 18 & 19 MAI 2018



>P utiliser un plugin de contenu Srer
/C@

Nous allons utiliser un de mes plugins

UP (Universal Plugin) permet de faire plein de choses

Son installation est identique 3 Joorrict
a celle du composant weblink |

Universal Plugin | " | | | _
Il faut aller dans le menu plugin upP - -

pour I'activer

ﬁ;ﬁ ' _ ' - PARIS 18 & 19 MAI 2018



>P  utiliser un plugin de contenu Srer
/C@

La famillo\"nnmla!

on revient sur le module « La famille Joomla »

on ajoute avant I'image {up image-magnify}
on ajoute apres I'image {/up image-magnify}
dans l'onglet « Parametres », on indique 'utilisation d’un plugin de contenu

ol A

Avec ce shortcode, Joomla va comprendre qu’il doit charger des ressources
javascript et modifier le code HTML pour ajouter un effet de loupe.

*—EI: . '“ ~ PARIS 18 & 19 MAI 2018
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pP  |es templates

o
“ 2. Pour un site homogene et évolutif,

o
t |8

Le service décoration de votre site

il est important de dissocier le fond et la forme !

|

JOOMLADAY FR

#JJ18FR
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pP  changer de template

Il est possible d’attribuer un template
a une ou plusieurs pages

@ Templates : Modifier le style

¢ ergsrraromer ] [] exagorwnecope | (@] o Cliquer sur le titre du template :
Nom.dL.lstyle* pr\otostar-Defa; Protostar - DefaU|t

Sélection des menus :

. L'onglet « Affecter a un menu »

[®] Inverser la sélection [®] Inverser la sélection
L] L]
Permet de choisir les pages
Mentions l&gales [ visiteurs
OLe [ Administration
Le [] - Présentation
[] - Les utiisateurs

s i '| ) - PARIS 18 & 19 MAI 2018
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pP  changer de template

Pour la démo, nous allons utiliser un template
qui permet de changer le nom des positions

B Systeme ~ Utilisateurs + Menus ~ Contenu ~ Composants ~ Extensions =  Aide ~

# Extensions : Gestion

v | Activer @ | Désactiver (™ | Régénérerle cache X | Désinstaller

©
helix Q Outils de recherche = Effacer

Installation
Mises & jour
[J Statut HNom= Emplacement Type Version
Decouvir O v French (France) language pack for  Site Fichier 3.00
Base de données Helix 3
Avertissemen ts
Helix3 - Aj Sit Plug-i 253
Installation de langues g v e 2 e Han
Sites de mise a jour O e shaper_helix3 Site Template 253
O [] System - Helix3 Framewaork Site Plug-in 253

‘D}A ' JOOMLADAY FR

pour gagner du temps,
le template est déja installé, mais non activé

Dans le menu Extensions > Gérer > Gestion
Rechercher le terme helix
Cliquer sur le bouton de la colonne Statut
pour activer le template et le plugin

#JDIBFR PARIS 18 & 19 MAI 2018



pP  changer de template

La sélection d’un template se fait a I'aide du menu
Extensions > Templates > Styles

@ Templates: Styles (Site)

# | Défaut & Modifier x| Dupliquer X | Supprimer
Templates
Styles

[] % protostar - Default

[] # shaper_helix3 - Par defaut

3 l‘
:. E I '
AP :
| JOOMLADAY FR

Déefaut |

-

#JJ18FR

| suffit de cliquer sur I'étoile
Pour sélectionner
Shaper_helix3

PARIS 18 & 19 MAI 2018



pP  changer de template

& Aaionn A
La Maison de
| I‘ Administration ~ Instaliation Les amis Lés partenaires Glossaire
Al Joomial
1

Voir le résultat

sur le site B T N R e

n La maison coté visiteurs

uhations la bienvenue dans le monde de Joomia que Nous aimernons tant partager avec vous ° -

Q La Maisonde »
JOO' | .lO! | en périphérie : modules

Les partonares

I'I= =JDI8FR PARIS 18 & 19 MAI 2018
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pP  changer de template

Chaque template utilise des
noms de position différents

@ Templates - Modifier le style ¥ Joomial

Helix3 permet de les

(7] HELX;
renommer
fain Body [MAjouter des colonnes = Ajouter une ligne ﬂParamN

Component position-7

PARIS 18 & 19 MAI 2018
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>) changer de template - rendu graphique

Protostar

Le nom Joomlal® est utilisé sous licence limitée de Open Source Matters, n

Mentions légales A F U J
i I le prapriétaire mondial de la marque. AFUfr n'est ni affilié 3 Open Source

Le portail joomla.fr L
P J "‘jsﬁ'lf'-“'““ F;-"";"‘-‘""f"l'f Matters ou au projet Joomlal® ni approuvé par eux.
Le forum joomla.fr Hillsateurs de Joamia:

© 2018 Maison-Joomla Haut de page

Helix3

_ e AFUJ (59

> Le portail joomia_fr Association Francaphone

des Utilisateurs de Joomla!®

> Le forum joomla.fr Le nom Joomla!® est utilisé sous licence limitée de Open Source Matters, le propriéfaire mondial de la marque. AFUJ.T
n'est ni affili€ a Open Source Matters ou au projet Joomlal® ni approuvé par eux.
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>P  changer de template - rendu graphique
0 ZL) e =
00 (v [~ footerhelix ‘

Il est parfois nécessaire de dupliquer les modules.
Chacun avec un rendu adapté au style du template

Exemple :

le bas de page protostar est sur fond blanc et helix sur fond gris.
La couleur des logos ne convient pas.

Les classes CSS utilisées pour la mise en page sont différentes
Protostar = Bootstrap2 - Helix3 = Bootstrap3

] »

- '“ T PARIS 18 & 19 MAI 2018
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pP  changer de template

Nous avons ajouté le module Slideshow CK
Il est publié a la position title
uniquement pour la page d’accueil
Cette position existe uniquement dans le template Helix

*—EI: . '“ ~ PARIS 18 & 19 MAI 2018
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pP  changer de template

En dehors de ces petites adaptations graphiques,
Le contenu reste identique.
REGLE IMPORTANTE
C’est le template qui définit le style
et non le rédacteur des articles

T '“ - PARIS 18 & 19 MAI 2018
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pP  Adaptation du template

Pour la suite, on revient sur le template protostar

@ Templates: Styles (Site)

# | Défaut & | Modifier

©

Templates

3y | Dupliguer X | Supprimer

Site

Styles
n # protostar - Default

[] # shaper_helix3 - Par defaut

' I ' #JDI8FR

JOOMLADAY FR

Defaut |

s
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> ) ajouter ses regles CSS

&,
ou comment modifier les sous-titres h3 des articles €r c,'ce

C’est un peu technique, mais il faut savoir le faire ...

Exercice pratique : ajouter ses régles CSS
Ch anger |a cou |e ur d es bO rd ures Vous aurez surement besoin de personnaliser le template, nous allons voir comment modifier

. les sous-titres hJ des articles en modifiant la couleur de la bordure en rouge.
pour tous les sous-titres des L .
1ére étape : identifier le sélecteur

articles m

Exercice pratique : ajouter ses régles CSS

Sur le site, afficher la page
Vous aurez surement besoin de personnaliser le template, nous allons voir comment modifier
Ad m | N istration > Tem p|ates les sous-titres h3 des articles en modifiant la couleur de la bordure en rouge.

1ére étape : identifier le sélecteur
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> ) ajouter ses regles CSS

ou comment modifier les sous-titres h3 des articles 7

lere étape : identifier le sélecteur

textes, de recadrer et redimensionner dm

clic-droit

« _Exercice pratique : ajoutersesréglesCSS .

1 1

p u IS Ilfnllo P R et R L eata sl hinenin Aa narconnalicoar la trmndats raoe allance vair cammmnnt modifior loe :
& {3 Inspecteur Conso [ Débogueur  {} Editeurdestyle (G Performances £k Mémoire = Réseau 5 Stockage =5

° -
I nspecter —+ Rechercher dans le H” & Reégles Calcule Disposition Animations

<main id="content” class="span3” role="main"> - Filtrer les styles

<!--Begin (bntent--> o e
. . . - \ 1 t
| b I 4 <div id="s@=tem-message-container”> =</ /div> ? =men t
S u r e OC CO n Ce rn e <div clasg"item-page” itemscope="" itemtype="https://schema.org/Article”
#content h3 1

border-bottom: Zpx @ #666 s0lid;

4 ifemprop="inlLanguage” content="fr-FR">
margin-top: 25px;

<div clss="page-header">= </div>

m

<div class="1cons"> </ div> ¥
<div ifemprop="articleBody"> | h1, h2, h3, h4, h5, h6, .site-title i
<p><ip> font-family: 'Open Sans', sans-serif;
<p ass="info"> =</ p> }
<p=<fp> h3 H
<g#n= la colonne de gauche, il v a 2 sous-menus :</p .
- font-size: 18px;
< el fuls>

line-height: 2@px;

<h3*Exercice pratique : ajouter ses regles (55</h3» X
Lpx=)<fpr
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textes, de recadrer et redimensionner dm

Afmuic cnira—s cornm hincmin An rinrcnnnalicar o tnmnlats reeae allance seoar coammond modiifior e 0
¢ L1 Inspecteur Conso [ Débogueur  {} Editeurdestyle (5 Performances £ Mémoire = Réseau B Stockage H
+ Rechercher dans le H & Regles Calculé Disposition Animations
<{main id="content" class="span9" role="main">» - Filtrer les styles
¢1--Begin @@ntent--3> o
. . . . element
<div 1d="sstem-message-container" > )</ /div> ) i
<div clas3¥"item-page"” itemscope="" itemtype="https://schema.org/Article"
5 Fcontent h3 i
<meta ifemprop="inlLanguage" content="fr-FR"> border-bottom: 2px @@ #666 solid;
<div cllkss="page-header">[—</div> margin-top: 25px;
<div cass="icons"» )</ /divs h
<div iffemprop="articleBody"> hl, h2, h3, hd4, h5, h6, .site-title {
<p> @</ p> font-family: 'Open Sans', sans-serif;
<p glass="info">[=1< p> 1
<p:ll-—-)</p> h3 i
<{g#n= la colonne de gauche, il ¥ a 2 sous-menus :</p .
. font-size: 18px;
< (PN

. . . > line-height: 28px;
<h3>*Exercice pratique : ajouter ses regles C55{/h3> . R

Lpr=1<fp>
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>

ajouter ses regles CSS

&,
ou comment modifier les sous-titres h3 des articles €r c,'Ce

2e étape : modifier le fichier CSS

Pour que la modification soit permanente, il faut I'ajouter au fichier de personnalisation de
votre template. Pour Protostar, il se nomme user.css et se trouve dans le dossier CSS

Dans templates > templates, cliquez sur "Détails et fichiers".

Chercher le dossier CSS, puis le fichier user.css.

Si ce fichier n'existe pas, créez-le. Ajouter en fin du fichier la nouvelle regle, soit :
#content h3 { border-bottom: 2px #F00 solid; }

Il est toujours préférable de procéder de la sorte pour 2 raisons :
* les modifications sont conservées lors d’'une mise a jour du template

* il est plus facile de se relire si tous les ajouts sont au méme endroit

ﬂ;ﬁ—-'— 'l D g PARIS 18 & 19 MAI 2018
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>P  ’inspecteur de code

C’est un outil proposé par votre navigateur
qui permet de comprendre beaucoup de choses

onglet inspecteur ou éléments
le code HTML et les styles CSS

onglet Console
les erreurs et avertissements.

onglet Réseau ou Network
les fichiers chargés et leurs tailles
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pP  Les utilisateurs

e iz __

Joomla est tres performant S 5
pour la gestion des droits

et acces des utilisateurs ;

ACL (Access Control List) .

*—Etl_ '“ - - PARIS 18 & 19 MAI 2018
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>

les langues

Joomla gere nativement du contenu dans plusieurs langues

menu langues installées
permet de gérer et d’installer de nouvelles langues

langues de contenu
permet de définir le titre du site et autres données pour chaque langue

substitutions
permet de changer les textes par défaut de Joomla!

ﬂ;ﬁ _ 'l D - PARIS 18 & 19 MAI 2018
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>P  site multilingue

Les étapes suivantes :

* créer un menu avec ses items par langue Langus
Toutes -
* extensions > Plugins > Systeme — Filtre de langue
. . English {en-GB)
activer et configurer Frangais (1R

* menu principal > item accueil
configurer I'onglet association

e créer un module pour chacun des menus
* créez un module de type “Changement de langue” U

#JDIBFR PARIS 18 & 19 MAI 2018
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>> Co nfig u rat i o n Site Systéme Serveur Filtres de texte Droits

Paramétres du site Parametres des métadonnées
Ie me n u Mom du site * La Maison de Joomla Description du site Un site démonstration de -
Joomla pour découvrir |E|
N ° ° ) : 5 environnement et apprendre 4 le -
Syste me > co nflgu ratlon Site hors-ligne = “ modifier et le compléter
- lcdnes d'édition en mouse- Modules = Mots-clés du site
est important over pour
Editeur par défaut Editeur - TinyMCE -
Captcha par défaut - Aucune Sélection - - Robots Index. Follow -
Accés par défaut Accés public - Droits légaux
Longueur des listes 20 -
Auteur du site MNon
Fils RSS/ATOM 10 -

Afficher la version de O

E-mail des fils Sans e-mail = Joomlal
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>P  configuration

Parametres SEO

Reéécriture dURL en clair
(SEF)

Reéécriture au ol des URL “ Mon

Ajouter un suffixe aux URL

Alias Unicode Oui “

FMom du site dans les titres Aprés
de pages

SEO : important pour avoir des URL
bien référencées par les moteurs de
recherche

nécessite de renommer htaccess.txt en .htaccess

http://votresite.fr/index.php?option=com contenté&view=article&id=5&Itemid=108

—

http://votresite.fr/administration/les-modules.html
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Parameétres du cache

>P  configuration

Gestion du cache Fichier -

Chemin du répertoire de

_ _ _ cache
Site Systéme Serveur Filtres de texte Droits

Durée du cache 15 =

Mise en cache spécifique Cui

selon la plate-farme

Parameétres systeme

*

Dossier 'logs’ soood’administrator/logs

Cache systéme Cache conservateur -
Serveur daide Francais (FE) - Aide de Joomlal - Actualizer

Configuration des sessions
Paramétres de débogage

Meéthode Base de données -

Débogage systéme Chui
Debogage de langue Oui

4k

Durée 15

Sessions partagees Cui
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>P  configuration

en cas de souci :

mettre rapport d’erreurs
sur développement

en production,
mettre sur aucun

=&

b

Site Systéme Serveur

Filtres de texte Droits

Parameétres du serveur Parameétres de |la base de données

Dossier temporaire wooodjdgftmp Type MySQLi =

Compression GZIP “ MNon Semveur hite * localhost

Rapport derreurs

Faorcer HTTPS

Localisation

Fuseau horaire

Parametres FTP

Activer le FTP

Parameétres du proxy

Activer un proxy

JOOMLADAY FR

Défaut - Ltilisateur * nom_utilisateur
Aucun = MNom de la base * jday18 jdg
Préfixe des tables jdg_

Temps universel, coordonné (...| =
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pP  configuration

en localhost,
serveur de mail = SMTP

avec les infos de votre FAI
ou de votre hébergeur

'—.;ﬂ:_ =
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Réglages e-mail

Envoi de mail

Désactiver I'envoi d'e-mails
en nombre

E-mail du site
MNom de l'expéditeur

E-mail pour 'en-téte
'Répondre &'

Texte pour l'en-téte "A’
Serveur de mail

Envoyer un e-mail de test

#JJ18FR

admin@maonsite fr
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pP et ensuite

NOUS avons vu comment gérer un site
maintenant

parlons de votre projet
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